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Overview of New and Improved Features of 

Microsoft Office Publisher 2007  

Welcome to Microsoft® Office Publisher 2007. This guide provides an overview of Office 

Publisher 2007, the desktop publishing and marketing materials solution for the 2007 

Microsoft Office system.  

Office Publisher 2007 can help you create a wide variety of high-quality publications and 

marketing materials—from single-page flyers to more complex brochures, catalogs, and 

e-mail newsletters. New tools guide you through the process of compiling your mailing 

list as well as creating, publishing, distributing, and printing your materials. Integration 

with Microsoft Office Outlook® 2007 with Business Contact Manager helps you track your 

marketing materials—in-house. 

The ninth release of Publisher since its introduction in 1991, Office Publisher 2007 

expands on the vision of helping business professionals create and distribute 

professional-quality, in-house publications and sales and marketing materials. With Office 

Publisher 2007, you will continue to see the investments we have made to core desktop 

publishing (DTP) functionality, as well as strategic investments in tools that help you 

share your publications easily with others. And when used with Office Outlook 2007 with 

Business Contact Manager, Office Publisher 2007 can help you manage and track 

successful marketing campaigns.  

This guide will familiarize you with the new and enhanced features of Office Publisher 

2007, including scenarios that demonstrate Office Publisher 2007 in action. 
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Create and Reuse High-Quality Publications That Reflect 

Your Business Brand  

Unless you are starting a new business, you are likely to have an established brand 

identity for your business, such as a business logo, color scheme, fonts, and business 

information (your tagline and address, for example). Office Publisher 2007 includes tools 

to help you efficiently create, customize, and reuse marketing communications materials 

that reflect your brand identity. Use the collection of intuitive design tools in Office 

Publisher 2007 to create custom publications. With Office Publisher 2007, you can use 

your creativity to take your publications further. 

• Improved! Choose from a library of hundreds of professionally designed 

templates. Office Publisher 2007 includes dozens of new templates for popular 

print, e-mail, and Web publication types such as brochures, postcards, flyers,  

e-mail newsletters, Web sites, and more. 

• New! Locate, preview, and open Office Publisher 2007 templates from the 

Microsoft Office Online Template Gallery within Office Publisher 2007.  

• New! Apply elements from your brand identity (including colors, fonts, logo, and 

business information) to all Office Publisher 2007 templates before you start 

creating your material, for a more relevant getting started experience.  

• Improved! Easily categorize, preview, open, and save your newly created 

publication templates within “My Templates.”  

• New! Office Publisher Tasks assist you with common Office Publisher 2007 

procedures for creating, publishing, and distribution. Turn to Office Publisher Tasks 

for help in adding text and images, changing the design, sending your publications 

as e-mail messages, and compiling your mailing list. Office Publisher Tasks even 

offer tips for effective writing. 

• Improved! Create a Business Information Set that includes your company name, 

contact information, and logo. If your business has different brand identities for 

different departments or product lines, you can use Office Publisher to create an 

unlimited number of business information sets to apply to your publications.  
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• Improved! Quickly build custom collateral such as a datasheet, directory, or 

catalog for distribution to a targeted client or client segment using Catalog Merge. 

The improved Catalog Merge wizard steps you through the process of merging 

text and photos from a database to create your publication.  

• Improved! Choose from more than 100 new blank page sizes when you start 

creating a publication from scratch, including postcards, booklets, and more.  

• Improved! DTP features enable you to further customize your publications using 

the Office Publisher 2007 collection of intuitive design, layout, and typography 

tools such as tracking and kerning, multiple master pages, baseline alignment, 

and more. 

• Improved! Design Checker helps you identify and correct any common desktop, 

commercial print, Web, or e-mail problems before you print or distribute. 

 

Personalize Publications and Marketing Materials for 

Professional, Targeted Results 

• New! Create personalized e-mail publications using the new E-mail Merge. 

Enhancements to Mail Merge now support sending personalized e-mail 

publications and enable you to add bookmarks to help readers navigate through 

an e-mail newsletter, as well as add personalized hyperlinks to direct users to 

unique online information.  

• New! Create, manage, and store a single-client list or data list in Office Publisher 

2007 by combining and editing lists from multiple sources, including Microsoft 

Office Excel® 2007 spreadsheet software, Office Outlook 2007, Office Outlook 

2007 with Business Contact Manager, Microsoft Office Access 2007, and more.  

• New! Use targeted lists from Office Outlook 2007 with Business Contact Manager. 

You can identify a target set of clients within Office Outlook 2007 with Business 

Contact Manager, save this filter list to an Office Outlook 2007 folder, and access 

this list from within Office Publisher 2007 to create and distribute targeted, 

personalized marketing materials. 

www.microsoft.com/office/publisher 3 



 

• New! Office Publisher Tasks assist you with common Office Publisher 2007 

procedures for creating, publishing, and distribution. Turn to Office Publisher Tasks 

for help in personalizing your publication, preparing your mailing lists, preparing 

your publication for commercial printing, publishing your material, and distributing 

and tracking your marketing effectiveness.  

• New! Manage and track marketing campaigns with Office Outlook 2007 with 

Business Contact Manager and Office Publisher 2007.  

• New! Measure the effectiveness of your marketing campaigns. Improved Office 

Publisher 2007 integration with Office Outlook 2007 with Business Contact 

Manager (available only in Microsoft Office Small Business 2007, Microsoft Office 

Professional 2007, and Microsoft Office Ultimate 2007) provides new tools to help 

you easily track marketing materials you send and the responses you receive. For 

example, you can add tracking codes to your Office Publisher 2007 materials and 

track client responses and opportunities within Office Outlook 2007 with Business 

Contact Manager. 

• Improved! Manage broad e-mail campaigns with Office Publisher 2007 and 

Microsoft List Builder, a powerful fee-based e-mail marketing tool that can help 

you run an e-mail marketing campaign. List Builder processes opt-out responses 

and tracks client responses. For more information about Microsoft List Builder, go 

to www.microsoft.com/smallbusiness/online/services-transition.mspx. 

 

Easily Share, Print, and Publish Your Publisher Publications  

Office Publisher 2007 provides new and improved ways for you to easily share, print, and 

publish your publications. 

• New! Publish your Office Publisher 2007 files as Portable Document Format (PDF) 

or XML Paper Specification (the new Windows Vista™ operating system XPS 

format) for easy sharing and printing.* Set options for online viewing, high-quality 

printing, or commercial press-ready printing. The press-ready PDF option and 

                                                 
* You can save as a PDF or XPS file from a 2007 Microsoft Office system program only after you install an add-
in. For more information, see Install and use a PDF or XPS add-in. 
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Pack and Go improvements make it easier than ever to print Office Publisher 2007 

files at commercial printers. 

• New! Apply an e-mail template to multipage publications—a newsletter, for 

example—and distribute it as an e-mail message. You can add bookmarks to help 

readers quickly browse the e-mail message. 

• Improved! The robust e-mail capabilities of Office Publisher 2007 enable your 

customers to receive e-mail publications that look as you intended, when using 

many popular e-mail programs and Web-based services. 

• Improved! Use Office Outlook 2007 or Outlook Express 6.0 or later to send your 

Publisher files as e-mail messages, Publisher attachments, or PDF or XPS 

attachments. 

• Improved! Full commercial printing support for larger quantities and higher 

quality printing makes it easier to take your publications to commercial printers. 

Office Publisher 2007 includes four-color process and spot color printing support, 

CMYK composite postscript support, and professional commercial printing tools. 

An improved Pack and Go Wizard bundles your Office Publisher 2007 files and 

associated graphics and fonts, as well as a new press-ready PDF file, for transport 

to a commercial printer.  

• The Convert to Web Publication feature enables you to convert print publications 

for viewing on the Web. Office Publisher 2007 makes it easy to add additional 

pages, hyperlinks, and a customizable navigation bar, as well as to edit, update, 

and post your publication for online viewing.  

 

 

Office Publisher 2007 in Action 
Contoso Landscape Design is a small, residential and commercial landscape design firm 

with fewer than 25 employees. Contoso’s marketing budget is limited and no single 

individual is tasked with creating sales and marketing materials. With Office Publisher 

2007, the company can create professional-quality publications and marketing materials 

in-house to help generate new business and to stay in touch with existing clients.  
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Contoso is currently preparing for the annual Flower and Garden Show where the 

company always gets leads for new clients. Office Publisher 2007 makes it easy for 

employees to create personalized flyers, postcards, brochures, catalogs, and e-mail 

messages that reflect the company’s brand identity. They also use tracking tools in Office 

Outlook 2007 with Business Contact Manager to measure the results of their marketing 

campaign, so they can effectively use their limited marketing budget.  

 

Figure 1: Use Office Publisher 2007 to create marketing materials with your business brand. 
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Efficiently Create and Reuse High-Quality 

Publications That Reflect Your Business Brand  

 
If you are a small business owner or employee, you probably find yourself juggling duties 

and accomplishing tasks that are not necessarily included in your job description. Most 

small businesses do not have a professional designer on staff; yet creating professional-

quality publications and marketing materials that accurately reflect your brand identity is 

a vital component of generating new business and maintaining relationships with existing 

clients. It is difficult and time-consuming to deal with programs created for professional 

designers. And if you outsource the creation of marketing materials to a design agency, 

you still contend with extended time lines and extra cost. Office Publisher 2007 gives you 

the tools you need to efficiently create, customize, and reuse your marketing materials. 

Get Started Quickly 

Choose from Hundreds of Templates—Offline or Online  

You can get started quickly by choosing from a library of hundreds of customizable design 

templates or blank publications, including newsletters, brochures, flyers, postcards, Web 

sites, e-mail formats, and more. These designer-created templates in more than 25 

categories help you start easily and finish quickly. When connected to the Internet, you 

can find, preview, and open high-quality Publisher templates from Office Online—right 

from within the Office Publisher 2007 Getting Started screen. The Publisher templates 

you download from the Office Online Template Gallery are now integrated into the Office 

Publisher Catalog (when you are connected to the Internet) and appear with the other 

templates in the same category. For example, you can view and open postcard templates 

from Office Online along with all the other postcard templates available in the offline 

Postcard category. 

The new Search function in Office Publisher 2007 helps you quickly find just the right 

template whether you are searching within Office Publisher 2007 or on Office Online. 
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Easily Save and Locate Your Customized Templates 

When you have created or customized a template that is just right for your needs, you do 

not want to waste time trying to locate it later. Office Publisher 2007 enables you to 

create and assign categories for any publication that you save as a template. These user-

created or downloaded templates are available from within My Templates and are easily 

accessible when you start Office Publisher 2007 or choose New from the File menu.  

Start with a Recently Used Publication  

Now, you can browse previews of recently used work in the startup screen, so finding 

your work is quick and easy.  

Start from Scratch with More Choices 

Choose from more than 100 blank publication templates, such as booklet and postcard 

templates. Use intuitive design and layout tools and your own creativity to produce 

unique materials.  

Apply Elements from Your Brand Identity 

Most businesses have an established brand identity with an existing logo, colors, and 

fonts that their clients know and recognize. New functionality enables you to apply your 

brand identity to every template within Office Publisher 2007 before actually starting. You 

can get dynamic previews of all Publisher templates with your brand elements applied, 

including colors, fonts, logo, and business information—making it easy to choose a 

template that works with your company’s brand identity.  

Create a Business Information Set 

Office Publisher 2007 now makes it easier for you to add your business name, contact 

information, and logo into all your publications. After you create your Business 

Information Set in Office Publisher 2007, you can apply it to all Publisher templates, or to 

your own publications. You get started faster with just the information you need, and you 

can maintain a consistent, professional look in all your materials. 
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Office Publisher 2007 in Action 
Eric Parkinson is Contoso Landscape Design’s office manager. One of Eric’s many duties is 

sending out direct-mail postcards for the Flower and Garden Show every year. Rather 

than spend unnecessary time and money outsourcing this project, Eric uses Office 

Publisher 2007 to quickly create a professional-quality postcard. Because Eric is under a 

tight deadline for getting this postcard created, printed, and distributed, he looks for an 

existing template that he can use without much modification.  

Eric goes to the Office Publisher 2007 Catalog where he applies elements of Contoso’s 

business brand—a custom color scheme and font scheme, as well as the business 

information set he created earlier—to all the templates within Office Publisher 2007. This 

enables him to quickly identify a Contoso-branded postcard that appeals to him. He can 

use the same or similar design if he later decides to create a flyer or brochure for the 

Flower and Garden Show. 

Because Eric may need to send out another postcard similar to the one he has just 

customized, he wants to save it as a template. From the File menu, he clicks Save As, 

and uses the drop-down menu in the Save As dialog box to choose Office Publisher 

Template. In the same dialog box, he clicks Category, creates a new template category 

called “Annual Garden Show,” and clicks Save. This new category and the template now 

appears in the My Templates section, which he can access every time he starts Office 

Publisher 2007 or chooses to create a new publication. He can now quickly organize and 

locate all Flower and Garden Show templates the same way. 
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Figure 2: Categorize and save modified or downloaded templates in My Templates for easy access. 

Build Custom Materials from a Database  

Marketing materials, such as datasheets or catalogs, are often most effective when they 

are up to date and targeted to a specific client or client segment. However, you do not 

always have the time to create a new, customized datasheet for every client meeting or 

conference or to create a new weekly sales sheet. With enhancements to Catalog Merge 

in Office Publisher 2007, you can quickly merge text and pictures from a data source (or 

combine elements from several data sources) to create a new publication that 

incorporates multiple records per page. This is especially helpful for frequently updated, 

content-rich publications such as price lists, datasheets, address books, or catalogs. Data 

sources include the standard sources such as spreadsheets and databases in Office Excel 

2007, Office Access 2007, Office Outlook 2007, and other formats. 
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Take Advantage of Existing Content 

Successful small businesses know how to work smarter. Why re-create or spend time 

searching for design elements you used in other publications? Why spend time retyping 

copy for a brochure when that copy has already been written in a datasheet? New and 

improved functionality in Office Publisher 2007 makes it easier to reuse content from 

your publications and other documents.  

With the new Content Library, you can access and save frequently used design elements, 

text, and graphics for use in other Publisher publications. You can easily add items to the 

Content Library: Just right-click the item, and then click Add to Content Library. To access 

items from the Content Library, click the Insert menu, choose the Content Library, and 

then select the items you want. 

 

You can also quickly reuse content from one publication type to another by changing the 

template. Just a few mouse clicks turns your multipage newsletter into an e-mail 

publication, or your letterhead into a business card, or the latest postcard into a flyer. 
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The improved integration of Office Publisher 2007 with other Microsoft Office system 

products and other popular programs enables you to copy and paste content from these 

other programs, as well as link or embed documents into your publication.  

Conversely, with the Save As Picture feature, you can save publication elements as a 

picture for reuse in other programs. With this feature, you can choose the appropriate 

resolution depending on what the element is used for (for example, 72 dpi for Web 

display, 150 dpi for desktop printing, or 300 dpi for commercial-press printing) and the 

right file type (for example, .jpg, .gif, .bmp, and .tiff). 

Get Help When You Need It 

There is no need to get stuck in any part of the process when creating publications or 

marketing materials. Office Publisher 2007 features the new Office Publisher Tasks, which 

guides you through the steps to get the outcome you want. Office Publisher Tasks 

exposes useful Office Publisher 2007 features and tips, including tips to get started, 

create or distribute publications, or track and follow up with a marketing campaign.   

You can also access an improved offline and online Help system that helps you get the 

most out of Office Publisher 2007. Search both offline and online Help for the latest 

topics and procedures. Online tutorials and demos help you learn new Office Publisher 

2007 functionality, and Office Online resources such as assistance and training provide 

you with further tips and instruction. 
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Office Publisher 2007 in Action 
Sandra I. Martinez, residential accounts manager, uses Office Publisher 2007 to create a 

new show specials sheet each day of the garden show (she also sends out a monthly 

specials sheet to a targeted list of high-end residential clients). From the Tools menu, 

Sandra chooses Mailings and Catalogs, and then chooses Catalog Merge. She creates a 

layout for the datasheet complete with the fields she wants from text and image fields 

within an Excel database. Improvements to Catalog Merge enable her to preview how all 

the merged records will look—even before she has completed the merge. When she is 

satisfied with the layout, she completes the merge. The publication now contains pictures 

and text descriptions of selected Contoso Landscape Design special offers for the week, 

and can be further customized using the intuitive design, layout, typography, and 

graphics tools of Office Publisher 2007. 

 

Figure 3: Create frequently updated or targeted materials quickly with improved Catalog Merge. 
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Use Improved Layout and Design Tools 

Whether you are starting from a template or a blank publication, you can further 

customize and refine your publication using the collection of intuitive design, layout, 

graphics, and typography tools in Office Publisher 2007. The following table describes 

some of the layout and design features found in Office Publisher 2007. 

Adjust images 
within Office 
Publisher 2007 

• Recolor pictures 

• Adjust brightness and contrast 

• Crop and compress images  

• Set text-wrapping properties  

• Insert an empty picture frame to use as a placeholder  

• Insert images from a scanner or digital camera 

• Rotate and flip images 

• Have more control with drawing tools and Auto Shapes 

• View image details with Graphics Manager 

• Save elements as a picture 

Take control of 
your layout 

• Create multiple master pages  

• Align text and objects with baseline alignment, movable rulers, grids, and guides 

• Link text frames 

• Easily navigate, move, rename, duplicate, insert a page, or apply a master page 
with page navigation 

Improve the 
appearance of 
text 

• Adjust character spacing with tracking and kerning 

• Set text-wrapping properties  

• Use TrueType fonts  

• Create bulleted and numbered lists 

• Add headers and footers 

• Handle paragraph and line breaks with widow and orphan controls  

Incorporate 
design elements 

• Create a consistent look with color and font schemes 

• Insert professionally designed objects from the Design Gallery 

• Check your work with Design Checker 
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Check Your Publications 

It is a good rule of thumb to double-check your work before printing, publishing, or 

sending it as an e-mail message. Office Publisher 2007 provides tools that help you 

ensure that your publication is free of common errors. To find out details about your 

images, you can use the improved graphic manager to view details such as file size, type, 

resolution, and location.   

Run the enhanced Design Checker before distributing or printing your publication to 

identify and fix any design errors. The Design Checker identifies common problems in 

commercial print, Web, and e-mail publications and helps you correct them. 

 

Office Publisher 2007 in Action 
Russell Hunter, Contoso Landscape Design’s commercial accounts manager, needs to 

create a unique, professional-quality invitation to a cocktail reception for his VIP clients 

on the opening night of the Flower and Garden Show. He starts by searching for an 

invitation template from the Office Online Template Gallery—which he accesses without 

having to leave Office Publisher 2007.  

He knows he wants to include a picture of the company’s most successful projects, which 

he already has captured with his digital camera. He is able to insert the photo directly 

from his camera into his publication. Because he wants to keep track of this photo, he 

uses the Save As Picture feature within Office Publisher 2007 to save the picture in a 

sufficient resolution and file type for commercial printing (but not as large as his camera 

could take)—such as a 300 dpi .tiff image. He then saves the photo to the location where 

he wants it. Using the graphics tools on the Picture toolbar, Russell fine-tunes the 

brightness and contrast of the picture and crops it. If he wanted to send this reception 

invitation in e-mail, he could use the Compress Pictures feature on the Picture toolbar to 

compress the picture and keep the file size manageable.  
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Because Russell needs to print a large number of invitations and wants them to be of top 

quality, he plans to have them printed at a local commercial print shop. He uses Office 

Publisher Tasks to help him with the process, including running the improved Design 

Checker. The Design Checker alerts him that the photo has low resolution and 

recommends that he replace it with a higher-resolution version. Using the Graphics 

Manager, Russell easily views the details of the picture and replaces it with the higher-

resolution version he saved earlier.   

 

Figure 4: Run Design Checker before sending your publications to print. 
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Personalize Publications and Marketing 

Materials for Professional, Targeted Results 

Your marketing efforts do not end after you have designed and printed your material. You 

need tools that can help you distribute your marketing materials in a streamlined, 

effective way, and in a way that helps you track the results of your marketing efforts. 

With Office Publisher 2007 and improved integration with Office Outlook 2007 with 

Business Contact Manager, you get tools to help you communicate with clients more 

easily and frequently, promote your business, and help your business grow.  

Consolidate Your Client Lists 

Many small businesses keep client information in a variety of sources, which creates 

headaches when the company wants to send out a comprehensive mailing. To address 

the fact that managing multiple client lists for marketing is difficult and time-consuming, 

Office Publisher 2007 features improved Mail Merge capabilities. You can now create, 

manage, and store a single-client list in Office Publisher 2007 by combining and editing 

lists from multiple sources, including Office Excel 2007, Office Outlook 2007, Office 

Outlook 2007 with Business Contact Manager, Office Access 2007, and more.  

 

Office Publisher 2007 in Action 
Contoso Landscape Design maintains an active client list in Office Outlook 2007 with 

Business Contact Manager, but account managers Sandra and Russell also keep potential 

client information—such as clients met at gardening shows—in Excel spreadsheets and 

Access databases. In the past, compiling a mailing list from all these sources has meant 

hours of headaches. But for this marketing campaign, Eric was able to quickly create and 

store a single-mailing list in Office Publisher 2007 by combining and editing lists from 

multiple sources. Sending out the Flower and Garden Show e-mail announcements has 

never been this easy. 
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Figure 5: Combine multiple lists within Publisher. 

With Office Publisher 2007, you now can use targeted lists from Office Outlook 2007 with 

Business Contact Manager. Identify a target set of clients within Office Outlook 2007 with 

Business Contact Manager, save this filtered list to an Office Outlook 2007 folder, and 

access this list from within Office Publisher 2007 to create targeted, personalized 

marketing activities. 

Personalize Your Communications 

For any business, communicating in meaningful ways with clients is key. Office Publisher 

2007 helps you give your clients the individual attention they deserve. Use enhanced Mail 

Merge, Catalog Merge, and new E-mail Merge with bookmarks and personalized 

hyperlinks to create personalized publications or mailings for print or e-mail distribution. 

Improved Merge Task Pane options guide you through the process of selecting lists, 
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adding text and image fields, and completing your mailing. Improvements in e-mail 

distribution and viewing, including support for sending multipage publications as a single-

page message, make it easier than ever to distribute a publication as an e-mail message. 

Office Publisher 2007 in Action 

With the new E-mail Merge capability, Eric can personalize the Flower and Garden Show 

e-mail newsletter. Not only can he personalize the greeting line and e-mail content, but 

he can also include personalized hyperlinks within each e-mail message, directing clients 

to specific Web pages. He also adds bookmarks to the articles within the newsletter to 

help his readers quickly navigate through the content.  

 

Figure 6: Personalize your e-mail messages with the new E-mail Merge. 
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Measure the Effectiveness of Your Marketing Campaigns 

Improved Office Publisher 2007 integration with Office Outlook 2007 with Business 

Contact Manager (available in Office Small Business 2007, Office Professional 2007, and 

Office Ultimate 2007) provides new tools to help you manage and track your marketing 

campaigns and new opportunities.  

The improved integration now enables you to initiate Publisher marketing campaigns 

from within Office Outlook 2007 with Business Contact Manager or Office Publisher 2007. 

Each marketing piece you send to contacts listed in your Office Outlook 2007 with 

Business Contact Manager database can be automatically linked to its recipients, taking 

the guesswork out of who received which piece. Additionally, you can create new 

opportunities within Office Outlook 2007 with Business Contact Manager as new and 

existing customers contact you about your marketing offer.   

The Marketing Campaign Tracking feature in Office Outlook 2007 with Business Contact 

Manager helps you determine the overall effectiveness of each campaign, so you can 

make informed budgeting decisions for future efforts. As you track the success of your 

marketing campaigns, you can use Office Publisher 2007 to quickly update, publish, and 

distribute your most effective marketing materials for reuse—saving your business time 

and money.  

If you use Office Publisher 2007 together with Office Outlook 2007 with Business Contact 

Manager and Microsoft List Builder (a separate fee-based online service), you can 

measure the effectiveness of e-mail marketing campaigns by tracking the number of 

people who opened the e-mail message—and who simply deleted it—as well as how 

many e-mail messages bounced back. 

 

www.microsoft.com/office/publisher 21



 

Office Publisher 2007 in Action 
Each Flower and Garden Show postcard that Eric sent included a tracking code and 

promotional copy that encouraged clients to bring the postcard to Contoso Landscape 

Design’s booth and receive a free garden spade. This enabled Eric to track which clients 

responded to the marketing campaign. With each client’s information noted in the 

tracking field of Office Outlook 2007 with Business Contact Manager, Eric could quickly 

send a personalized e-mail message just a week after the show. In addition, all the 

marketing material sent out for the show and displayed at the booth (the e-mail 

message, postcard, and print piece) included a single tracking code, so the account 

managers could track how many new leads resulted from the Flower and Garden Show 

postcards. Eric could then make informed marketing budget decisions for the next show. 

EE--mail Campaignmail CampaignEE--mail Campaignmail Campaign

 Publisher E-mail Merge

 

Figure 7: Office Outlook 2007 with Business Contact Manager works with Office Publisher 2007 to 

help you measure the success of your campaigns.  
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Easily Share, Print, and Publish Your 

Publications 

It is important to know that the materials you create can be easily shared in the proper 

format, for the right audience. Being responsive to your clients and their needs means 

that you need to be able to easily distribute your marketing materials, send your 

publications to commercial printers if necessary, or publish your materials to the Web. 

And you want to make sure that the materials you send in e-mail show up in your client’s 

inbox looking the same as they did when you sent them. Whether you are sending a flyer 

in e-mail, sending a large-quantity mailing to a commercial printer, or preparing a 

publication for viewing on the Web (or creating a new Web site), Office Publisher 2007 

provides new and improved ways for you to share, print, and publish publications with 

ease.  

Share Your Publications  

You can now publish your Office Publisher 2007 files in a fixed file format—PDF or XML 

Paper Specification (XPS)—for hassle-free sharing and printing without needing additional 

third-party programs. PDF settings within Office Publisher 2007 include options for online 

viewing, desktop printing, and commercial press-ready printing. This means that you can 

share your materials across platforms and applications without worrying about 

compatibility issues. 

In addition, the improved Pack and Go Wizard packs up your file for a commercial printer 

and now includes a press-ready PDF file. Printers can choose to either work with the 

native Office Publisher 2007 file and the built-in prepress tools, or—for those printers 

with a PDF workflow—to use the press-ready PDF file.  

Send E-Mail with Confidence 

E-mail is increasingly becoming the preferred method of communication for many clients 

and businesses. Office Publisher 2007 helps you send effective e-mail marketing 
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communications that look as good as your printed marketing materials—and are just as 

easy to create. Office Publisher 2007 includes new tools to help you reuse your print 

publications and send them as e-mail marketing materials.  

For example, you can now easily convert a multipage publication to an e-mail format and 

send it as a single message. Turn that four-page newsletter into an e-mail message and 

add bookmarks to help your readers quickly browse the message.  

To send e-mail publications from Office Publisher 2007, you must be using Office Outlook 

2007, Outlook Express 6.0, or later releases of Outlook Express as your default e-mail 

client. The improved e-mail capabilities help ensure that your clients receive e-mail 

publications with the formatting and design intact, whether they are using earlier 

releases of Office Outlook, Outlook Express 5.5 or later, Hotmail®, or other popular Web-

based services or e-mail clients such as AOL Mail and Yahoo Mail.  

In addition, with Office Publisher 2007 you now can choose to send Publisher files as PDF 

or XPS attachments. 

Take Your Publications to the Web 

Having a Web presence is a necessity for any business today. Outsourcing your Web site 

is time-consuming and expensive and can be inefficient if you want to make quick 

changes. With Web site templates and other easy-to-use tools, Office Publisher 2007 

makes it painless to add content to your existing Office Publisher Web site or to swiftly 

build a Web site. 

For a quick and inexpensive way to give your business a presence on the Web, the Office 

Publisher 2007 Easy Web Site Builder Wizard helps you get your Web site up and 

running.  

Use Office Publisher 2007 to easily update or convert your publications for viewing on the 

Web and add to your existing Web site. With the Web Tools toolbar, you can add 

additional pages, hyperlinks, and a customizable navigation bar. And you can preview 

your Web publication before posting it. Support for incremental file upload makes it easy 

to update your site. 

www.microsoft.com/office/publisher 24



 

Office Publisher 2007 in Action 
Eric wants to publicize the Flower and Garden Show online and through e-mail 

announcements to Contoso Landscape Design clients. Tasked with both adding new 

content to the Contoso Web site and sending a monthly e-mail newsletter that includes 

Garden Show information, Eric saves time by taking advantage of material that has 

already been created for a print newsletter. Eric converts the newsletter into a quick Web 

page, complete with a navigation bar. He can also save it as a PDF file for online viewing, 

distribution, sending to a commercial printer, or posting as a downloadable file on 

Contoso’s Web site. 

To send the multipage newsletter as an e-mail message, Eric changes the template from 

Newsletter to E-mail, chooses a design, and makes a few additional edits to the message 

and layout. He then sends the message using Office Outlook 2007 or Outlook Express 6.0 

or later. He can be confident that Contoso’s clients can view the publication just as he 

intended when they are using Office Outlook 2007, Outlook Express 6.0 or later, or 

popular Web-based e-mail services and e-mail clients such as Hotmail, AOL Mail, and 

more.  
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Figure 8: Reuse content with Office Publisher 2007. For example, change a four-page newsletter to 

an e-mail message just by changing the template. 

Send Your Materials to Commercial Printers 

For materials that need to be printed in large quantities or at a higher quality, sending 

your Publisher publications to a commercial printer is easier than ever. Office Publisher 

2007 offers full commercial printing support, including four-color process printing, spot 

color printing, CMYK composite postscript, and more. And with the new Publish as Press-

Ready PDF feature, commercial printers using a PDF workflow can more efficiently output 

Office Publisher files.  
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Summary  

In today’s competitive business environment, keeping in touch with existing clients and 

reaching prospective clients is essential to staying in business; creating communication 

materials quickly and efficiently, in-house, makes this easier.  

Microsoft Office Publisher 2007 brings together all the tools you need to create, 

personalize, and distribute effective page layout publications and marketing materials. 

Get more out of Office Publisher 2007 when you also use Office Outlook 2007 with 

Business Contact Manager (available with Office Small Business 2007, Office Professional 

2007, and Office Ultimate 2007)—manage and track marketing campaigns, and create 

effective communications materials for print, Web, and e-mail—all in-house. 
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Resources 

For more information about Office Publisher 2007, please visit: 

http://www.microsoft.com/office/publisher 

 

 

 

 

System Requirements 

For complete system requirements, visit http://www.microsoft.com/office/publisher 
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